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BAØI TAÄP 3 

BAØI TOAÙN HEÄ KHUNG  
Trong baøi naøy, baïn seõ thöïc haønh giaûi moät heä khung coù kích thöôùc nhö sau: 

 

� Chieàu daøi khung laø 5m vaø chieàu cao laø 3m 

� Khung chòu taûi troïng phaân boá ñeàu vôùi q = 1.15T/m 

� Vaät lieäu laø beâ toâng coát theùp(BTCT) vôùi moâ ñun ñaøn hoài : E = 2.65106 T/m2. 

� Heä soá Poisson v = 0.18 

� Troïng löôïng rieâng cuûa BTCT laø : 2.5 T/m3 

� Kích thöôùc cuûa coät 0.25 x 0.3. 

� Kích thöôùc cuûa daàm 0.2 x 0.4. 

Ñeå giaûi ñöôïc baøi toaùn baïn haõy tieán haønh trình töï qua caùc böôùc sau: 

1. KHÔÛI ÑOÄNG SAP 2000 

Töø trình ñôn Start choïn Windows > Programs > SAP 2000NonLinear. 

2. CHOÏN ÑÔN VÒ TÍNH TOAÙN 

      Nhaáp chuoät vaøo tam giaùc beân phaûi trong 
phaàn cuoái maøn hình ñeå choïn ñôn vò laø Ton-m. 
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3. TAÏO MOÄT MOÂ HÌNH MAÃU 

     Ñeå taïo moâ hình maãu ñaàu tieân baïn vaøo trình 
ñôn File > New Modol from Template. 

 
Hoäp thoaïi Model Template xuaát hieän : 

 
Trong hoäp thoaïi Model Template baïn duøng chuoät nhaáp choïn vaøo maãu thöù hai nhö hình 

con troû chæ beân treân ñeå xuaát hieän hoäp thoaïi Portal Frame. 

 Hoäp thoaïi Portal Frame xuaát hieän : 

 
 Trong hoäp thoaïi Portal Frame, baïn tieán haønh khai baùo caùc thoâng soá nhö sau : 

� Ñaàu tieân nhaáp chuoät vaøo Restraints ñeå boû choïn. 

� Nhaáp choïn vaøo Gridlines ñeå boû ñöôøng löôùi. 

� Taïi Number of Stories (soá taàng) nhaäp giaù trò : 1 

� Taïi Number of Bays (soá nhòp) nhaäp giaù trò : 1 

� Trong muïc Story Heigth (chieàu cao taàng) baïn nhaäp giaù trò : 3 

� Trong hoäp Bay Width (beà roäng cuûa nhòp) nhaäp giaù trò : 5. 

� Sau cuøng baïn nhaáp Ok ñeå ñoùng hoäp thoaïi Portal Frame. 

Maøn hình xuaát hieän hai cöûa soå laøm vieäc, khi ñoù baïn duøng chuoät nhaáp choïn vaøo Close(x) 
cuûa 3D view ñeå ñoùng cöûasoå khoâng gian baèng hình chieáu phoái caûnh, luùc naøy coøn laïi moät cöûa soå 
ñoù laø X-Y Plane @ Y= 0 baïn seõ tieán haønh laøm vieäc treân maët phaúng OXZ naøy. 
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Heä khung ñöôïc hình thaønh 

4. HIEÅN THÒ CAÙC THOÂNG SOÁ 

Ñeå hieån thò caùc thoâng soá treân khung ñaàu tieân baïn vaøo trình ñôn View > Set Elements 
hay baïn nhaán toå hôïp phím Ctrl + E 

 

Hoäp thoaïi Set Elements xuaát hieän : 

 

 Trong hoäp thoaïi Set Elements taïi muïc Joints baïn duøng chuoät nhaáp choïn vaøo Labels, taïi 
muïc Frames nhaáp choïn vaøo Labels vaø nhaáp choïn OK ñeå ñoùng hoäp thoaïi. 
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Caùc thoâng soá xuaát hieän treân khung 

5. HIEÄU CHÆNH MOÂ HÌNH 

Nhaáp chuoät vaøo phaàn töû thöù nhaát (nhö hình con troû chæ beân döôùi) sau ñoù baïn nhaán phím 
Delete treân baøn phím ñeå xoaù phaàn töû naøy. 

 

Vò trí nhaáp chuoät 

 

Khung khi nhaán Delete 
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 Loaïi boû taát caû nhöõng thaønh phaàn dö treân 
vuøng laøm vieäc baèng caùch, baïn duøng chuoät nhaáp 
choïn vaøo Refresh Window . 

 
 

 

Hình khi thöïc hieän 

6. HIEÄU CHÆNH SOÁ THÖÙ TÖÏ 

            Ñeå thay ñoåi soá thöù töï cho nuùt, ñaàu tieân 
baïn nhaáp chuoät vaøo bieåu töôïng all treân thanh 
coâng cuï nhö hình sau:  

 
Taát caû ñoái töôïng ñaõ ñöôïc choïn 

 Baây giôø baïn vaøo trình ñôn Edit > Change Labels ñeå xuaát hieän hoäp thoaïi Relabel 
Selected Items 
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Hoäp thoaïi Relabel Selected Items xuaát hieän : 

 

Trong hoäp thoaïi Relabel Selected Items baïn tieán haønh khai baùo nhö sau: 

� Trong muïc Select Element (s) (choïn ñoái töôïng) baïn duøng chuoät nhaáp vaøo Frames 
ñeå boû choïn. 

� Trong muïc Change Label Initialization, taïi muïc Next Number (soá keá tieáp) baïn 
nhaäp giaù trò laø 1 vaø Increment (böôùc nhaûy) laø 1. 

� Nhaáp choïn OK ñeå ñoùng hoäp thoaïi. 

 

Hình khi thöïc hieän xong 

7. KHAI BAÙO CAÙC ÑAËC TRÖNG VAÄT LIEÄU 

            Ñeå khai baùo ñaëc tröng vaät lieäu baïn 
thöïc hieän nhö sau :  Ñaàu tieân duøng chuoät 
nhaáp choïn vaøo coâng cuï Zoom out One 
Step ñeå thu nhoû vuøng laøm vieäc vöøa vôùi 
cheá ñoä laøm vieäc theo yù  baïn. 
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       Tieáp theo baïn vaøo trình ñôn Define > 
Materials ñeå xuaát hieän hoäp thoaïi Define 
Materials 

 
Hoäp thoaïi Define Materials xuaát hieän : 

 

 Trong hoäp thoaïi Define Materials taïi 
muïc Materials baïn nhaáp chuoät vaøo CONC, 
trong muïc Click to nhaáp chuoät vaøo Modify / 
Show Material ñeå xuaát hieän hoäp thoaïi 
Material Property Data. 
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Trong hoäp thoaïi Material Property Data taïi muïc Analysis Property Data baïn tieán 
haønh khai baùo nhö sau : 

� Mass per unit Volume nhaäp vaøo giaù trò :  0 (khoái löôïng rieâng)                                                       

� Weight per unit Volume baïn nhaäp giaù vaøo 2.5 (troïng löôïng rieâng cuûa beâ toâng coát 
theùp) 

� Modulus of elasticity : 2.56e6 (heä soá moâ ñun ñaøn hoài)  

� Poissons ratil : 0.18 (heä soá poisson). 

� Coeff of thermal expansion (heä soá daõn nôû vì nhieät) : 0. 

� Tieáp theo nhaáp choïn OK ñeå ñoùng hoäp thoaïi Material Property Data. 

 

� Nhaáp choïn vaøo OK ñeå ñoùng hoäp thoaïi Define Materials. 

8. KHAI BAÙO ÑAËC TRÖNG HÌNH HOÏC 

      Ñaàu tieân baïn vaøo trình ñôn Define > 
Frame Sections. 

 
Hoäp thoaïi Define Frame Sections xuaát hieän. 

 

        Trong hoäp thoaïi Define Frame 
Sections taïi muïc Click to baïn duøng 
chuoät nhaáp choïn vaøo tam giaùc beân phaûi 
cuûa hoäp Add / Wide Flange sau ñoù 
tröôït thanh tröôït ñöùng ñeå choïn Add 
Rectangular nhö hình beân döôùi. 
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 Hoäp thoaïi Rectangular Section xuaát hieän : 

 

Trong hoäp thoaïi Rectangular Section baïn khai baùo cho coät nhö sau : 

� Trong muïc Section Name baïn nhaäp vaøo doøng chöõ COT. 

� Taïi muïc Material khai baùo vaät lieäu cuûa coät vaø CONC. 

� Trong muïc Dimensions taïi Depth nhaäp giaù trò laø 0.25 vaø Width laø 0.3 

� Nhaáp choïn OK ñeå ñoùng hoäp thoaïi Rectangular Section 

Khi ñoùng hoäp thoaïi Rectangular Section baïn thaáy trong hoäp thoaïi Define Frame 
Sections taïi muïc Name xuaát hieän teân COT vöøa nhaäp. 

Baây giôø ñeå khai baùo cho daàm baïn duøng chuoät nhaáp choïn vaøo tam giaùc beân phaûi cuûa Add 
Rectangular ñeå choïn Add Rectangular. 
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Hoäp thoaïi Rectangular Section xuaát hieän : 

 

    Trong hoäp thoaïi 
Rectangular Section baïn thöïc hieän 
nhö phaàn khai baùo cho coät nhöng 
trong muïc Dimensions taïi Depth 
baïn nhaäp vaøo giaù trò laø 0.2 vaø 
Width laø 0.4 sau ñoù nhaáp OK ñeå 
ñoùng hoäp thoaïi Rectangular 
Section. 

 

� Nhaáp choïn OK ñeå ñoùng hoäp thoaïi Define Frame Sections. 
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9. KHAI BAÙO ÑAËC TRÖNG CHO PHAÀN TÖÛ 

Ñeå tieán haønh khai baùo ñaëc tröng cho phaàn töû khung baïn tieán haønh thöïc hieän nhö sau: 

Tröôùc tieân duøng chuoät nhaáp choïn vaøo thanh daàm (coù kyù hieäu laø soá 3) nhö hình con troû chæ 
beân döôùi. 

 
Vò trí nhaáp chuoät 

 Baây giôø baïn vaøo trình ñôn Assign > Frame > Sections ñeå xuaát hieän hoäp thoaïi Define 
Frame Sections 

 
 Hoäp thoaïi Define Frame Sections xuaát hieän : 

 
 Trong hoäp thoaïi Define Frame Sections taïi muïc Frame Sections trong muïc Name baïn 
duøng chuoät nhaáp choïn vaøo DAM sau ñoù choïn OK, khi ñoù treân phaàn töû soá 3 ñaõ xuaát hieän teân 
DAM nhö hình beân döôùi. 
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 Töông töï nhö vaäy baïn duøng chuoät nhaáp choïn vaøo thanh soá hai nhö hình beân döôùi.  

 
Töông töï nhö treân vaøo trình ñôn Assign > Frame > Sections ñeå xuaát hieän hoäp thoaïi 

Define Frame Sections. 

 

      Trong hoäp thoaïi Define 
Frame Sections taïi muïc Frame 
Sections trong muïc Name baïn 
duøng chuoät nhaáp choïn vaøo COT 
sau ñoù choïn OK. 
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Hình khi thöïc hieän 

10.GAÙN TAÛI TROÏNG CHO DAÀM VAØO COÄT 

Khai baùo taát caû tröôøng hoäp taûi :  

       Ñeå khai baùo taát caû tröôøng hoäp taûi, ñaàu tieân 
baïn vaøo trình ñôn Define > Static Load 
Cases. 

 
Hoäp thoaïi Define Static Load Case Names xuaát hieän :                                                                    

 
Trong hoäp thoaïi Define Static Load Case Names baïn tieán haønh theo trình töï sau: 

� Trong muïc Load (teân caùc tröôøng hôïp taûi troïng) baïn nhaäp vaøo chuoãi kyù töï TLBT,  

� Taïi muïc Type nhaáp vaøo tam giaùc beân phaûi ñeå choïn DEAD (taûi troïng tónh), 

� Trong muïc Self Weight Multiplier (heä soá coù keå ñeán taûi troïng baûn thaân keát caáu) 
baïn nhaäp vaøo giaù trò laø 1. 

� Nhaáp choïn vaøo Change Load ñeå chaáp nhaän söï thay ñoåi teân cuûa taûi. 
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Taûi ñaõ ñöôïc nhaäp vaøo 

Ñeå khai baùo tieáp nhöõng loaïi taûi khaùc baïn nhaáp choïn vaøo TLBT ñeåø ñoåi thaønh doøng chöõ 
PHAN BO, vaø trong muïc Type choïn LIVE (taûi troïng ñoäng), trong Self Weight Multiplier nhaäp 
vaøo giaù trò laø 0.0, sau ñoù baïn nhaáp choïn vaøo Add new Load nhö hoäp thoaïi beân döôùi. 

 

Hình khi nhaäp vaøo PHAN BO 

 

Hình khi nhaáp choïn vaøo Add new Load 
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 Töông töï nhö vaäy, baïn nhaäp vaøo taûi TAPTRUNG nhö hình beân döôùi vaø nhaáp OK ñeå 
ñoùng hoäp thoaïi. 

 
Hình khi nhaäp vaøo TAPTRUNG 

 
Hình khi thöïc hieän xong 

11.GAÙN TAÛI TROÏNG LEÂN DAÀM 

� Ñeå gaùn taûi troïng leân daàm vaø coät, tröôùc tieân baïn duøng chuoät nhaáp choïn vaøo phaàn töû 
thöù 3 nhö hình con troû beân döôùi. 
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       Tieáp theo baïn vaøo trình ñôn 
Assign > Frame static Loads < Point and 
Uniform. 

 
 Hoäp thoaïi Point and Uniform Span Loads xuaát hieän : 

 
 Trong hoäp thoaïi Point and Uniform Span Loads  töø muïc Load Case Name baïn duøng 
chuoät nhaáp choïn vaøo tam giaùc beân phaûi choïn PHANBO, trong muïc Uniform Load nhaäp vaøo giaù 
trò laø –1.15, sau ñoù nhaáp choïn OK ñeå ñoùng hoäp thoaïi Point and Uniform Span Loads. 

 
Taûi troïng phaân boá ñaõ xuaát hieän treân daàm 
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� Tieáp theo baïn nhaáp choïn vaøo phaàn töû thöù hai nhö hình beân döôùi ñeå gaùn taûi troïng leân 
phaàn töû naøy. 

 

Vò trí nhaáp chuoät 

Baây giôø baïn goïi leänh Assign > Frame static Loads < Point and Uniform. 

Trong hoäp thoaïi Point and Uniform Span Loads taïi muïc Load Case Name baïn duøng 
chuoät nhaáp choïn vaøo tam giaùc beân phaûi choïn TAPTRUNG. 

� Trong muïc Direction baïn choïn GlobalX. Nhaáp choïn vaøo Absolute Distance from 
End – I. Trong muïc Point Loads taïi Distance cuûa hoäp soá 1 baïn nhaäp giaù trò laø1.5 vaø 
Load laø –2.5. Taïi muïc Uniform Load nhaäp giaù trò laø 0.0. Sau cuøng nhaáp choïn OK ñeå 
ñoùng hoäp thoaïi. 
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 Hình khi thöïc hieän xong 

� Khai baùo moâ men taäp trung baèng caùch duøng chuoät nhaáp choïn vaøo nuùt soá 1 nhö hình 
beân döôùi. 

 

Vò trí nhaáp chuoät 

� Tieáp theo baïn vaøo trình ñôn Assign 
> Joint Static Loads > Forces. 

 
Hoäp thoaïi Joint Forces xuaát hieän : 
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� Trong hoäp thoaïi Joint 
Forces taïi muïc Load 
Case Name baïn nhaáp 
chuoät vaøo tam giaùc beân 
phaûi ñeå choïn 
TAPTRUNG, 

�  Trong muïc Loads taïi 
Monent Global YY 
nhaäp vaøo giaù trò : –1.5 
vaø nhaáp choïn OK ñeå 
ñoùng hoäp thoaïi Joint 
Forces. 

 

 
12.TOÅ HÔÏP TAÛI  

Ñeå toå hôïp taûi baïn vaøo trình ñôn Define > Load combinations. 

 

     Hoäp thoaïi Define Load Combinations xuaát hieän. 
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 Trong hoäp thoaïi Define Load Combinations baïn duøng chuoät nhaáp choïn vaøo Add New 
Combo ñeå xuaát hieän hoäp thoaïi Load Combinations Data. 

 Hoäp thoaïi Load Combinations Data xuaát hieän 

 

    Trong hoäp thoaïi Load Combinations 
Data baïn tieán haønh khai baùo theo trình töï 
sau : 

� Trong muïc Load Combinations 
Name nhaäp vaøo COMB1. 

� Trong muïc Load Combinations 
Type nhaáp choïn ADD. 

� Trong muïc Title nhaäp vaøo kyù töï 
sau TT+1.2 TPB 

� Trong muïc Define Combination 
baïn nhaáp vaøo tam giaùc beân phaûi 
ñeå choïn PHANBO. 

� Trong hoäp Scale Factor nhaäp vaøo 
giaù trò laø 1.2. 

 

� Sau cuøng baïn nhaáp choïn Add vaø choïn OK ñeå ñoùng hoäp thoaïi. 

Luùc baáy giôø trong hoäp thoaïi Define Load Combinations ñaõ xuaát hieän toå hôïp taûi thöù nhaát 
laø COMB1 nhö hình beân döôùi. 

 

� Tieáp theo baïn nhaáp chuoät 
vaøo Add New Combo nhö 
hình con troû chæ ñeå khai baùo 
toå hôïp taûi thöù hai. 
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Hoäp thoaïi Load Combinations Data xuaát hieän : 

 

           Töông töï nhö treân nhöng trong muïc 
Title nhaäp vaøo kyù töï sau TT+1.4 TTT, trong 
muïc Define Combination baïn nhaáp vaøo 
tam giaùc beân phaûi ñeå choïn TAPTRUNG, 
trong hoäp Scale Factor nhaäp vaøo giaù trò laø 
1.4 sau ñoù nhaáp chuoät vaøo Add vaø choïn OK. 

� Nhaáp chuoät vaøo Add New Combo ñeå 
khai baùo toå hôïp taûi thöù 3. 

� Hoäp thoaïi Load Combinations Data 
xuaát hieän : 

 

 

 Thöïc hieän laïi böôùc treân ñeå tieán haønh 
toå hôïp taûi thöù 3 (COMB3) nhö sau : taïi muïc 
Title nhaäp vaøo kyù töï TT+PB+TT vaø muïc 
Define Combination baïn nhaáp vaøo tam giaùc 
beân phaûi ñeå choïn PHANBO, trong muïc 
Scale Factor nhaäp vaøo giaù trò laø 1 nhaáp 
choïn Add. 

Chuù yù : Neáu khi khai baùo taûi taäp trung vaø 
phaân boá baïn thaáy baùo loãi khi ñoù baïn nhaáp 
choïn Ok vaø thöïc hieän tieáp. 

Baây giôø baïn nhaáp chuoät vaøo TAP 
TRUNG vaø choïn Add sau ñoù choïn OK ñeå 
keát thuùc vieäc toå hôïp taûi. 
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13.KHAI BAÙO ÑIEÀU KIEÂN BIEÂN 

Duøng chuoät nhaáp choïn vaøo nuùt thöù 2 nhö hình sau : 

  
� Tieáp theo baïn vaøo trình ñôn Assign 

> Joint > Restaints 

 
      Hoäp thoaïi Joint Restraints xuaát hieän : 

 

� Trong hoäp thoaïi Joint Restraints 
trong muïc Fast Restraints baïn 
duøng chuoät nhaáp choïn vaøo bieåu 
töôïng ngaøm thöù nhaát nhö hình con 
troû chæ beân caïnh vaø nhaáp choïn OK 
ñeå ñoùng hoäp thoaïi. 
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Khung ñaõ xuaát hieän bieåu töôïng ngaøm 

 Töông töï nhö vaäy baïn duøng chuoät nhaáp choïn vaøo nuùt thöù nhaát nhö hình sau : 

 
Hình khi nhaáp choïn vaøo nuùt 

� Baây giôø baïn vaøo trình ñôn Assign > 
Joint > Restaints, 

�  Khi hoäp thoaïi Joint Restaints xuaát 
hieän trong muïc Fast Restraints baïn 
nhaáp vaøo bieåu töôïng khôùp thöù hai 
nhö hình beân vaø nhaáp choïn OK ñeå 
ñoùng hoäp thoaïi Joint Restaints. 
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Hình khi thöïc hieän xong 

14.CHOÏN THOÂNG SOÁ CHO QUAÙ TRÌNH GIAÛI BAØI TOAÙN 

� Tröôùc tieân baïn vaøo trình ñôn 
Analyze > Set Options. 

 
 Hoäp thoaïi Analysis Options xuaát hieän : 

 
Trong hoäp thoaïi Analysis Options baïn thöïc hieän theo trình töï sau: 

� Taïi muïc Available DOFs baïn duøng chuoät nhaáp choïn vaøo UX,UZ, RY coøn caùc oâ khaùc 
ñeå troáng (nhö trong hoäp thoaïi treân). 

� Nhaáp chuoät vaøo Generate Output sau ñoù nhaáp choïn Select Output Options ñeå hieån 
thò hoäp thoaïi Select Output Results. 
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Hoäp thoaïi Select Output Results xuaát hieän :  

 
� Trong hoäp thoaïi Select Output Results duøng chuoät nhaáp choïn vaøo Displacements, 

sau ñoù nhaáp choïn vaøo Select/ Show Loads ñeå xuaát hieän hoäp thoaïi Select Output. 

� Trong hoäp thoaïi Select Output baïn nhaáp choïn vaøo loaïi taûi sau ñoù nhaán vaø giöõ phím 
Shift nhaáp choïn töøng loaïi taûi ñeå choïn taát caû tröôøng hôïp taûi vaø nhaáp OK ñeå ñoùng hoäp 
thoaïi. 

� Thöïc hieän töông töï nhö treân cho nhöõng phaàn beân döôùi. 

� Nhaáp chuoät vaøo Reaction/ Spring Forces 

� Töông töï nhaáp choïn vaøo Frame Forces ñeå ñöa ra noäi löïc cuûa phaàn töû Frame 

� Sau cuøng nhaáp choïn OK ñeå ñoùng hoäp thoaïi Select Output  

� Nhaáp choïn OK ñeå ñoùng hoäp thoaïi Select Output Results 

15. GIAÛI BAØI TOAÙN 

� Ñeå giaûi baøi toaùn, tröôùc tieân baïn choïn 
maët caét baèng caùch nhaáp choïn vaøo bieåu 
töôïng ALL treân thanh coâng cuï 
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� Baây giôø baïn vaøo trình ñôn Assign > Frame > Output Segments. 

 

Hoäp thoaïi Frame Output Segments xuaát hieän : 

 

� Trong hoäp thoaïi Frame 
Output Segments taïi 
muïc Number Of 
Segments baïn nhaäp vaøo 
giaù trò laø 2 sau ñoù nhaáp 
choïn OK ñeå ñoùng hoäp 
thoaïi Frame Output 
Segments. 

 

� Ñeå baøi toaùn ñöôïc chính 
xaùc baïn chia daàm ra 
thaønh nhieàu phaàn baèng 
caùch duøng chuoät nhaáp 
choïn vaøo daàm nhö hình 
beân. 

 Tieáp theo baïn goïi leänh Edit > Divide Frames. 
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 Hoäp thoaïi Divide Selected Frames xuaát hieän : 

 

� Trong hoäp thoaïi Divide Selected 
Frames taïi muïc Divide into baïn nhaäp 
vaøo giaù trò : 8 Frames, trong muïc Last / 
first radio laø1  

� Sau cuøng nhaáp choïn OK ñeå ñoùng hoäp 
thoaïi. 

 

Hình khi thöïc hieän xong 

� Töông töï nhö vaäy baïn duøng chuoät nhaáp vaøo coät vaø khai baùo taïi taïi muïc Divide into baïn 
nhaäp vaøo giaù trò : 4 Frames, trong muïc Last / first radio laø1 sau cuøng nhaáp choïn vaøo OK 
ñeå ñoùng hoäp thoaïi. 

  

� Thöïc hieän giaûi baèng caùch vaøo trình ñôn 
Analyze > Run hay duøng phím F5 treân 
baøn phím.  
Hoäp thoaïi Save Model File As xuaát hieän : 
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Khi ñoù baïn thaáy xuaát hieän hoäp thoaïi Save Model File As, trong muïc Save in cuûa hoäp 
thoaïi Save Model File As baïn chæ ñöôøng daãn ñeå löu file, trong muïc File name baïn ñaët teân cho 
file vaø nhaáp choïn Save ñeå file ñöôïc löu. 

 
Baây giôø maùy tieán haønh giaûi, khi maùy giaûi xong seõ xuaát hieän hoäp thoaïi Analysis 

Complete neáu xuaát hieän doøng Error baïn phaûi tieán haønh khai baùo laïi.  

 
� Trong hoäp thoaïi Analysis Complete baïn 

nhaäp choïn OK ñeå xem keát quaû chuyeån 
vò nhö hình sau: 

 
 Hình chuyeån vò 
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16. XEM KEÁT QUAÛ 

Ñeå xem keát quaû baïn thöïc hieän nhö sau : Ñaàu tieân baïn vaøo trình ñôn Display > Show 
Element Forces / Stresses> Frames. 

 
 Hoäp thoaïi Member Force Diagram for Frames xuaát hieän : 

 

� Trong hoäp thoaïi Member Force 
Diagram for Frames taïi Load baïn duøng 
chuoät nhaáp choïn vaøo tam giaùc beân phaûi 
ñeå choïn COMB3Combo 

� Taïi muïc Component nhaáp chuoät vaøo 
Axial Force ñeå xem löïc doïc nhö hình 
beân döôùi. 

� Nhaáp choïn vaøo OK ñeå ñoùng hoäp thoaïi. 
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� Caùch thöïc hieän töông töï nhö treân : Vaøo 
trình ñôn Display > Show Element 
Forces / Stresses> Frames. 

� Trong hoäp thoaïi Member Force 
Diagram for Frames taïi Load baïn duøng 
chuoät nhaáp choïn vaøo tam giaùc beân phaûi 
ñeå choïn COMB3Combo 

� Tieáp theo duøng chuoät nhaáp vaøo Moment 
3-3 ñeå xem Moment xoaén quanh truïc ñòa 
phöông 3-3. 

 
Bieåu ñoà momen  

�  Thöïc hieän nhö böôùc treân. Sau ñoù ñeå 
xem löïc caét baïn duøng chuoät nhaáp choïn 
vaøo Shear 2-2 nhö hoäp thoaïi hình beân. 
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Bieåu ñoà löïc caét 

 Chuùc baïn thaønh coâng. 
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